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Microchip Information 

Trademarks 

The “Microchip” name and logo, the “M” logo, and other names, logos, and brands are registered and 
unregistered trademarks of Microchip Technology Incorporated or its affiliates and/or subsidiaries in the 
United States and/or other countries (“Microchip Trademarks”). Information regarding Microchip 
Trademarks can be found at https://www.microchip.com/en-us/about/legalinformation/microchip-
trademarks. 

ISBN: 

Legal Notice 

This publication and the information herein may be used only with Microchip products, including to 

design, test, and integrate Microchip products with your application. Use of this information in any other 

manner violates these terms. Information regarding device applications is provided only for your 

convenience and may be superseded by updates. It is your responsibility to ensure that your application 

meets with your specifications. Contact your local Microchip sales office for additional support or, obtain 

additional support at www.microchip.com/en-us/support/design-help/client-support-services. 

THIS INFORMATION IS PROVIDED BY MICROCHIP "AS IS". MICROCHIP MAKES NO 

REPRESENTATIONS OR WARRANTIES OF ANY KIND WHETHER EXPRESS OR IMPLIED, WRITTEN 

OR ORAL, STATUTORY OR OTHERWISE, RELATED TO THE INFORMATION INCLUDING BUT NOT 

LIMITED TO ANY IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY, AND 

FITNESS FOR A PARTICULAR PURPOSE, OR WARRANTIES RELATED TO ITS CONDITION, 

QUALITY, OR PERFORMANCE. 

IN NO EVENT WILL MICROCHIP BE LIABLE FOR ANY INDIRECT, SPECIAL, PUNITIVE, INCIDENTAL, 

OR CONSEQUENTIAL LOSS, DAMAGE, COST, OR EXPENSE OF ANY KIND WHATSOEVER 

RELATED TO THE INFORMATION OR ITS USE, HOWEVER CAUSED, EVEN IF MICROCHIP HAS 

BEEN ADVISED OF THE POSSIBILITY OR THE DAMAGES ARE FORESEEABLE. TO THE FULLEST 

EXTENT ALLOWED BY LAW, MICROCHIP'S TOTAL LIABILITY ON ALL CLAIMS IN ANY WAY 

RELATED TO THE INFORMATION OR ITS USE WILL NOT EXCEED THE AMOUNT OF FEES, IF ANY, 

THAT YOU HAVE PAID DIRECTLY TO MICROCHIP FOR THE INFORMATION. 

Use of Microchip devices in life support and/or safety applications is entirely at the buyer's risk, and the 

buyer agrees to defend, indemnify and hold harmless Microchip from any and all damages, claims, suits, 

or expenses resulting from such use. No licenses are conveyed, implicitly or otherwise, under any 

Microchip intellectual property rights unless otherwise stated. 

Microchip Devices Code Protection Feature 

Note the following details of the code protection feature on Microchip products: 

• Microchip products meet the specifications contained in their particular Microchip Data Sheet. 

• Microchip believes that its family of products is secure when used in the intended manner, within 

operating specifications, and under normal conditions. 

• Microchip values and aggressively protects its intellectual property rights. Attempts to breach the 

code protection features of Microchip product is strictly prohibited and may violate the Digital 

Millennium Copyright Act. 

• Neither Microchip nor any other semiconductor manufacturer can guarantee the security of its code. 

Code protection does not mean that we are guaranteeing the product is “unbreakable”. Code 

protection is constantly evolving. Microchip is committed to continuously improving the code 

protection features of our products. 
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 Preface  

NOTICE TO CUSTOMERS 

All documentation becomes dated, and this manual is no exception. Microchip tools and 
documentation are constantly evolving to meet customer needs, so some actual dialogs 
and/or tool descriptions may differ from those in this document. Please refer to our website 
(microchip.com) to obtain the latest documentation available. 

Documents are identified with a “DS” number. This number is located on the bottom of each 
page, in front of the page number. The numbering convention for the DS number is 
“DSXXXXXXXXA”, where “XXXXXXXX” is the document number and “A” is the revision level 
of the document. 

For the most up-to-date information on development tools, see the MPLAB® IDE online help. 
Select the Help menu, and then Topics, to open a list of available online help files. 

 

INTRODUCTION 

This chapter contains general information that is useful to know before using the Mixed-Signal Explorer 

GUI. Items discussed in this chapter include: 

• Document Layout 

• Conventions Used in this Guide 

• Recommended Reading 

• The Microchip Website 

• Product Change Notification Service 

• Customer Support 

• Document Revision History 

• Index 

DOCUMENT LAYOUT 

This document describes how to use the Mixed-Signal Explorer GUI. The manual layout is as follows: 

• Chapter 1. “Software Overview” – Important information about the Mixed-Signal Explorer GUI.  

• Chapter 2. “Usage workflow” – Describes how this GUI can be used. 

• Chapter 3. “SAR ADC” – Describes SAR ADC application support  

• Chapter 4. “Delta-Sigma ADC support” – Describes the Delta-Sigma features and the methods 

through which these features are supported (Generic SPI and Firmware acquisition) 

• Chapter 5. “DAC Support Through Generic SPI” - Describes the support for DAC Families 

• Chapter 6. “DAC Support Through Generic I2C” - Describes the support for DAC Families 

• Chapter 7. “Digipot Support Through Generic I2C/SPI” - Describes the support for Digipot 

Families 

 

 

https://www.microchip.com/
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CONVENTIONS USED IN THIS GUIDE 

This manual uses the following documentation conventions: 

DOCUMENTATION CONVENTIONS 

Description Represents Examples 

Arial font: 

Italic characters 

Referenced books MPLAB® IDE User’s Guide 

Emphasized text ...is the only compiler... 

Initial caps 

A window the Output window 

A dialog the Settings dialog 

A menu selection select Enable Programmer 

Quotes 
A field name in a window or 

dialog 
“Save project before build” 

Underlined, italic text with 

right angle bracket 
A menu path File > Save 

Bold characters 

A dialog button Click OK 

A tab Click the Power tab 

N‘Rnnnn 

A number in verilog format, 

where N is the total number 

of digits, R is the radix and n 

is a digit. 

4‘b0010, 2‘hF1 

Text in angle brackets < > A key on the keyboard Press <Enter>, <F1> 

Courier New font: 

Plain Courier New 

Sample source code #define START 

Filenames autoexec.bat 

File paths c:\mcc18\h 

Keywords _asm, _endasm, static 

Command-line options -Opa+, -Opa- 

Bit values 0, 1 

Constants 0xFF, ‘A’ 
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Italic Courier New A variable argument 
file.o, where file can be 

any valid filename 

Square brackets [ ] Optional arguments 
mcc18 [options] file 

[options] 

Curly brackets and pipe  

character: { | } 

Choice of mutually exclusive 

arguments; an OR selection 
errorlevel {0|1} 

Ellipses... 

Replaces repeated text 
var_name [, 

var_name...] 

Represents code -supplied by 

user 

void main (void) 

{ ... 

} 
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RECOMMENDED READING 

This user’s guide describes how to use the Mixed-Signal Explorer Graphical User Interface (GUI). Other 

useful documents are listed below. The following Microchip document is available and recommended as a 

supplemental reference resource:  

- Mixed-Signal-Explorer-User-Guide.pdf 

- Mixed-Signal-Explorer-Release-Notes.pdf 

THE MICROCHIP WEBSITE 

Microchip provides online support via our website at microchip.com where files and information are easily 

available to customers. The website contains the following: 

• Product Support – Data sheets and errata, application notes and sample programs, design 

resources, user’s guides and hardware support documents, latest software releases and archived 

software 

• General Technical Support – Frequently Asked Questions (FAQs), technical support requests, 

online discussion groups, Microchip consultant program member listing 

• Business of Microchip – Product selector and ordering guides, latest Microchip press releases, 

listing of seminars and events, listings of Microchip sales offices, distributors and factory 

representatives 

PRODUCT CHANGE NOTIFICATION SERVICE  

Microchip’s customer notification service helps keep customers current on Microchip products. 

Subscribers receive e-mail notifications whenever there are changes, updates, revisions or errata related 

to a specified product family or development tool of interest. 

To register, access the Microchip website at microchip.com, select Product Change Notification and 

follow the registration instructions. 

CUSTOMER SUPPORT 

Users of Microchip products can receive assistance through several channels: 

• Distributor or Representative 

• Local Sales Office 

• Field Application Engineer (FAE) 

• Technical Support 

Customers should contact their distributor, representative or field application engineer (FAE) for support. 

Local sales offices are also available to help customers. A listing of sales offices and locations is included 

in the back of this document, under Worldwide Sales and Service. 

Technical support is available at: microchip.com/support. 

DOCUMENT REVISION HISTORY 

Revision E (September 2025) 

• Update for Delta-Sigma ADC Full-Speed, Digital potentiometer and I2C DAC devices support. 

Revision D (May 2025) 

• Update for DAC devices support. 

https://www.microchip.com/
https://www.microchip.com/
https://www.microchip.com/support
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Revision C (March 2025) 

• Update for firmware update support. 

Revision B (February 2025) 

• Update for Delta-Sigma support. 

Revision A (November 2024) 

• Initial Release of this document. 
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Chapter 1.  SOFTWARE OVERVIEW 

 

Mixed-Signal Explorer GUI is a GUI software for showcasing the Microchip Mixed-Signal Evaluation boards 

capabilities. It is a component of the Mixed-Signal Explorer software package. 

For more detailed information and instruction on how to install the package and implicitly the GUI, see the following 

documentation: “Mixed-Signal Explorer User Guide.pdf” 

When the GUI starts the device selection view is available, as shown in Figure 1-1.  

Figure 1-1: GUI Window – device selection 

 

The Device Selection section (1) can be expanded and the desired device selected.  

The Connection and status toolbar (2) provides the board connection options and information about its status. 

The Menu (3) contains several sections detailed below.  
  

Figure 1-2 File Menu 

 
The File Menu Figure 1-2 offers the option to download (export) the current set of data acquired for ADCs into a 

file in the Downloads folder. Data can also be imported, but the length of the codes in the imported file must match 
the Samples No. selected in the application. 
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The Help Menu will display the GUI help (User’s Guide) and an About popup, which will show the licenses of all 
the Flutter dependencies and the versions of the Service and backend library. 

The Fimware Update Menu opens the Firmware Update Figure 1-3 from where the connected Data Capture 
board firmware can be updated.  

To update the firmware 
1. Connect to the service and select the desired device 
2. The application will try to automatically select a firmware file. To manually select the file, click the Firmware 

text box (1). This opens a window to select the firmware file.  
3. Select the FW Update button (2). A message appears on top of the bar indicating if the update succeeded 

or failed. 
4. To switch back to the Connection View, press the Connection View menu button. 
 

Figure 1-3 Firmware Update 

 

 

 

The Settings (4) button shows/hides the general application settings Figure 1-4  

Figure 1-4 Settings Panel 

  

One of the settings is the color of the plots. To pick a color for a certain plot, pick the analysis, channel id, line type 

and click on Color button (1). A new control (Figure 1-5)will appear in the main panel where you can pick the desired 

color for the plot line. After selecting the desired color (by using the sliders and then the color picker), click 

once again on the Color button (1) control in Settings. This will restore the initial main panel and use the 

selected color for the desired plot line.  
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Figure 1-5 Chart line color selection 
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Chapter 2.  USAGE WORKFLOW 
The application can be used in offline mode without connecting it to the MCHP USB Bridge Service. However, in 

offline mode, the application has limited functionality. 

To use the GUI in online mode (connected to an actual device), connect to a MCHP USB Bridge Service instance, 

either installed locally on the same PC with the GUI or installed remotely on an accessible host. The devices should 

be connected to the PC hosting the MCHP USB Bridge Service. The MCHP USB Bridge Service needs to be started 

as per information described in “Mixed-Signal Explorer User Guide.pdf”. The GUI does this operation for the service 

installed on localhost upon connection to localhost.  

To establish a connection, use the Connection and Status toolbar Figure 2-1.  

Figure 2-1 Connection and status toolbar 

 

The Connection toolbar can be hidden by pressing the Hide Connection View button (1) 

The Host field (2) contains the service host address: IP address for remote connections, local or localhost if using the 

service running on the same computer as the GUI. When connecting to localhost, the service will be started 

automatically, which momentarily opens a command prompt to do this operation. 

The Connect button (3) establishes a connection to the service. The button turns green on a successful connection 

to the service. 

Once connected to the service, the connection to a board can be established from the Board List (4) drop down 

menu Figure 2-2. If the connection to the board is successful, the Board List field will have a green border. The 

Refresh button (5) updates the Board List with the boards that are currently available on the machine. The list also 

refreshes automatically every 30 seconds. 

Figure 2-2 Board List selection 

 

The Device Selection (6) button opens the Device Selection view Figure 2-3. Each row can be expanded to show 

available communication protocols for each device type and currently supported device families. Each device family 

can be expanded and the desired device selected.  
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Figure 2-3 Expanded Device Selection view 

 

The Operation Mode (7) is automatically set to a compatible mode for the selected device. Some devices support 

multiple operation modes.   

The Slot Selection (8) drop down menu chooses which mikroBUS™ slot from the connected Data Capture board will 

be used for the currently selected device.  

The Status section (9) displays information about the application operation. If an error is detected the ⓘ icon will 

turn red and more details will be displayed when hovering over it.  

The software can, in rare circumstances, disconnect due to an Ethernet connection timeout, which is indicated by a 

red border around the connection fields. In such cases, disconnect the host by clicking the Connection button (3) 

and perform the connection steps again. 
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Chapter 3.  SAR ADC  
 

The SAR ADC interface contains multiple options for viewing and analyzing the data captured from the ADC. By 

default, the Time Domain analysis Figure 3-1 is loaded when a SAR ADC is selected.  

Figure 3-1 SAR ADC Time Domain view 

 

To change to a different analysis type, select the desired mode from the Analysis Tabs (1). 

The Analysis Settings section (2) contains options for the currently selected analysis mode.  

The Metrics / Results panel (3) displays the current metrics/results for the data processing corresponding to the 

currently selected analysis mode. This panel can be hidden by pressing the Results button (6). 

The Acquisition toolbar (4) is used to control data acquisition from the connected device. 

Figure 3-2 Acquisition control 

 

 

To continuously acquire data from the ADC, press the Start/Stop Acquisition button (1). The button will then change 

to a stop icon. 

The Single Acquisition button (2) can be used to perform a single data acquisition from the connected ADC. 

The Save button (3) will save 5 seconds of data while continuous acquisition is in Time Domain mode. The data is 

saved as a file in the Downloads folder. While not all data is displayed in the GUI for some configuration, like the SAR 

ADC 1Msps sample rate with lower periodogram lengths, all data can be retrieved from the backend using the Save 

button and can be later replayed by using other tools like the ADC Evaluation GUI.   
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After the acquisition is started the signal is displayed in the Plot Panel (5).  

Figure 3-3 Plot controls 

 

The Plot panel contains several control buttons Figure 3-3. The Auto scale Y-axis button (1) is useful when the data 
is out of the range of the GUI's sensible limits for the current plot. When the button is colored in a lighter shade, it is 
selected. 
 
The Zoom X-axis button (2) enables horizontal zoom. When the button is colored in a lighter shade, it is selected. 
 
The Zoom Y-axis button (3) enables vertical zoom. When the button is colored in a lighter shade, it is selected. 
To zoom in, keep the left mouse button pressed and span the area to be zoomed. After that, release the button. 

Also, another method to zoom in includes clicking the desired center of zooming then pressing CTRL+. 

To zoom out, right-click or press CTRL-. 

To restore the original view, double-click the left mouse button. 

To view other types of analyses running in continuous mode, click the corresponding tab in the Analysis Tab 

Selection.  

Figure 3-4 shows the FFT plot for a 9.76 kHz, -5.39 dBFS input signal. 

 

Figure 3-5 represents the INL for a 7 kHz, 4V input signal. To test INL use a Signal Generator with better resolution 

and INL than the tested device. 

Figure 3-4 Spectral Analysis 



MIXED-SIGNAL EXPLORER GUI USER’S GUIDE 

© 2024-2025 Microchip Technology Inc. and its subsidiaries  page  15 

 

Figure 3-5 Linearity Analysis 

 

 

 

Figure 3-6 Bit Analysis 
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Chapter 2.  DELTA-SIGMA ADC SUPPORT  
The Delta-Sigma ADC family supports two operating modes: Data Exchange via Generic SPI and Firmware 

Acquisition via SPI. By default, Firmware Acquisition is selected. This mode can use full speed supported by the part, 

but not all registers can be read in this mode.  

The Delta-Sigma ADC interface contains multiple options for viewing and analyzing the data captured from the ADC. 

By default, the Time Domain analysis is shown.  

Figure 2-1 Time Domain Analysis 

 

To change to a different analysis type, select the desired mode from the Analysis Tabs (1). 

The Analysis Settings section (2) contains options for the currently selected analysis mode.  

The Metrics / Results panel (3) displays the current metrics/results for the data processing corresponding to the 

currently selected analysis mode. This panel can be hidden by pressing the Results button (6). 

The Acquisition toolbar (4) is used to control data acquisition from the connected device. 

Figure 2-2 Acquisition control 

 

 

To continuously acquire data from the ADC, press the Start/Stop Acquisition button (1). The button will then change 

to a stop icon. 

The Single Acquisition button (2) can be used to perform a single data acquisition from the connected ADC. 

The Save button (3) will save 5 seconds of data while continuous acquisition is in Time Domain mode. The data is 

saved as a file in the Downloads folder.   
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The ADC operation mode can be selected from the Channel Control toolbar (5). Here the desired mode can be 

switched between MUX and Scan (Figure 2-3)  and the acquisition channels selected.  

Figure 2-3 Scan Mode 

 

 

After the acquisition is started the signal is displayed in the Plot Panel (6).  

Figure 2-4 Plot controls 

 

The Plot panel contains several control buttons Figure 3-3. The Auto scale Y-axis button (1) is useful when the data 
is out of the range of the GUI's sensible limits for the current plot. When the button is colored in a lighter shade, it is 
selected. 
 
The Zoom X-axis button (2) enables horizontal zoom. When the button is colored in a lighter shade, it is selected. 
 
The Zoom Y-axis button (3) enables vertical zoom. When the button is colored in a lighter shade, it is selected. 
To zoom in, keep the left mouse button pressed and span the area to be zoomed. After that, release the button. 

Also, another method to zoom in includes clicking the desired center of zooming then pressing CTRL+. 

To zoom out, right-click or press CTRL-. 

To restore the original view, double-click the left mouse button. 

To view other types of analyses running in continuous mode, click the corresponding tab in the Analysis Tab 

Selection.  

The Register button (7) opens the Register View (Figure 2-5) which allows read-write access to the ADC’s registers. 
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Figure 2-5 Register View 

 

Fields recommended to be modified for the current Generic SPI configuration are highlighted with a green 

outline.  

The upper part of Register View contains five buttons for various register operations. 

The Reset to Default button (1) will reset the device registers to their default values. The registers are not 

automatically written to the device, only the register view is updated. To save the new value into the device press 

the Save (6) button next to each register line. Register values can be modified. However, some of them are 

changed by the backend when the operation mode is set to Generic SPI. This provides a working baseline for 

acquisitions. 

The Read All (2) button will read all the device registers and update the Register View. Each register cand also 

be individually read by pressing the Read Register (7) button available on each register line.  

After changing a register value, use the Save Register (6) button to write the value into the device.  

The Save Register to File (4) and Import Registers (5) can be used to save the current register values to an 

external file and then import the values back into the application.  

If the Mixed-Signal Explorer GUI is connected to an incorrect slot (which does not have a MCP356xR device 

connected), Register View returns false values. 
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Pressing the Change View (3) button changes the Register View into the Register Value View (Figure 2-6), 

where the value of each register cand be viewed and modified.  

Figure 2-6 Register Value View 

 

 

Figure 2-7 Histogram view 

 

The integral nonlinearity (INL) analysis is not currently available for Delta-Sigma ADCs, instead replaced with a 

Histogram analysis. 
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Figure 2-8 Bit Analysis 

 

4.1 Generic SPI Sample Rate Limitation 

The Mixed-Signal Explorer GUI currently supports only a single family of Delta-Sigma devices: MCP3564xR.  

Delta-Sigma support is currently provided through Generic SPI. The backend functionality of this method 

consists of sending SPI acquisition commands from the PC to the connected ADC device; commands that are 

relayed through the Generic SPI firmware module. This method has a data rate limit of around 4 ksps, thus 

restricting the recognized signal to a maximum of 2 ksps (which is the related Nyquist frequency). The desired 

sample rate can be set in Mixed-Signal Explorer GUI with limits based on factors like baud rate, over-sampling 

ratio (OSR), internal clock, Generic SPI and ADC sample rate. The desired sample rate is rounded to achieve a 

sample period that is a multiple of 25µs which modifies the actual sample rate.  

The options provided by the sample number field (Sample no.) are powers of 2 with values around the actual 

sample rate. This ensures acquisition time is short when acquiring the same amount of data as a SAR ADC but 

with lower sample rates. 

4.2 Generic SPI FFT Considerations 

When doing signal processing on the samples provided by Generic SPI, two fields must be filled with custom 

values for the FFT fundamental signal and metrics to be correctly calculated. These fields are DC leakage and 

Spectral Leakage and are measured in kHz. They need to be adjusted for Generic SPI: 0.01 kHz for a signal of 

at least 10 Hz to be detected properly. Switching tabs reloads the default values for the DC and Spectral 

Leakage fields: 0.01kHz for Generic SPI and 2kHZ for other operation modes. For Generic SPI, these settings 

change also based on the sample rate. 

4.3 Generic SPI Baud Rate 

The Baud Rate can be set in the Codes Tab. It has a minimum value of 1, a default value of 20,000,000 and a 

maximum value of 100,000,000. 
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Chapter 3.  DAC SUPPORT THROUGH GENERIC SPI  
 

The MCP48CXBX and MCP48CXDX families of DAC devices both support the Generic SPI communication 

protocol. 

Figure 3-1 Codes display with registers 

 

The Control Toolbar (1) provides options related to the main view.  

The Channel drop down (2) selects which channels are visible and configurable in the main view.  

The Sample rate controls (3) affect the communication speed with the device.  

The Codes/Volts (4) buttons control which type of view is displayed. Figure 3-2 shows the Volts view charts. 

Figure 3-2 Volts display 
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The Start button (5) starts/stops the signal injection configured for each channel. A sinusoidal or DC form signal 

can be injected into any DAC channel. While the signal is injected, Register View and Connection View options 

are disabled. 

The Signal Configuration section (6) in each channel provides control over the generated signal parameters.  

The Register View button (7) opens the Register View section (8) which allows read-write access to the DAC’s 

registers 

Fields recommended to be modified for the current Generic SPI configuration are highlighted with a green 

outline.  

The upper part of Register View contains five buttons for various register operations. 

Figure 3-3 Register view fields 

 

The Reset to Default button (1) will reset the device registers to their default values. The registers are not 

automatically written to the device, only the register view is updated. To save the new value into the device press 

the Save (6) button next to each register line.  

The Read All (2) button will read all the device registers and update the Register View. Each register cand also 

be individually read by pressing the Read Register (7) button available on each register line.  

After changing a register value, use the Save Register (6) button to write the value into the device.  

The Save Register to File (4) and Import Registers (5) can be used to save the current register values to an 

external file and then import the values back into the application.  

If the MCP48CXBX/DX device is misconfigured in the Device Drop-down (for example, selecting an ADC device 

on slot 1 when a DAC device is already physically attached), displaying Register View corrupts the SPI 

connection. To fix this issue, reset both the GUI and the PIC32MZ Mixed Signal Data Capture Board 

(EV64F02A)." 

Pressing the Change View (3) button changes the Register View into the Register Value View (Figure 3-4), 

where the value of each register cand be viewed and modified. 
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Figure 3-4 Register value view 
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Chapter 4.  DAC SUPPORT THROUGH GENERIC I2C 
 

The MCP47CXBX and MCP47CXBX DAC families are supported via the Generic I2C communication protocol from 

the Mixed Signal Explorer GUI. The view and control features are described in more detail in the DAC SUPPORT 

THROUGH GENERIC SPI chapter. 

Each I2C device has the I2C address defined in its device file, saved in the devices folder from your program 

installation location. The value is listed under the <unitId>…</unitId> section. This value is automatically read 

and input into the I2C address field (1). The address can be manually changed, or the device xml file modified for 

future automatic loading.  

Figure 4-1 DAC I2C view 
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Chapter 5.  DIGIPOT SUPPORT THROUGH I2C/SPI 
 

The MCP4xU83 device family is supported in both SPI and I2C communication modes. When selecting the part, I2C 

is used by default. The operating mode can be changed from the Operation Mode field (9).  

Each I2C device has the I2C address defined in its device file, saved in the devices folder from your program 

installation location. The value is listed under the <unitId>…</unitId> section. This value is automatically read 

and input into the I2C address field (10). The address can be manually changed, or the device xml file modified for 

future automatic loading.  

 

Figure 5-1 Digipot View 

 

The main view contains controls for the device’s wiper values and terminal pin configurations.  

The Device selection (1) drop down menu contains the different resistance part numbers available. This selection 

affects the Rs calculation in the main view.  

The Wiper control section (2) provides different options to modify the wiper value for each channel. The desired 

resistance can be input in the Rs field (3) and the closest available value, based on the device’s resolution, will be 

chosen and written into the wiper.  

The Wiper code field (4) can be written directly or modified using the Wiper slider control (5).  

The Increment (7) button and the Decrement (6) button send the increment/decrement commands to the device and 

will affect the wiper values according to the device’s settings. 

The Terminal control section (8) provides an easy option to configure each channel’s terminal pins. Based on the 

selected options, the Rheostat / Digipot / Terminal Shutdown modes will be selected.  

The Register View button (11) opens the Register View section (12) which allows read-write access to the device’s 

registers 
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The upper part of Register View contains five buttons for various register operations 

Figure 5-2 Register View fields 

 

The Reset to Default button (1) will reset the device registers to their default values. The registers are not 

automatically written to the device, only the register view is updated. To save the new value into the device press 

the Save (6) button next to each register line.  

The Read All (2) button will read all the device registers and update the Register View. Each register cand also 

be individually read by pressing the Read Register (7) button available on each register line.  

After changing a register value, use the Save Register (6) button to write the value into the device.  

The Save Register to File (4) and Import Registers (5) can be used to save the current register values to an 

external file and then import the values back into the application.  

Pressing the Change View (3) button changes the Register View into the Register Value View (Figure 5-3), 

where the value of each register cand be viewed and modified. 

Figure 5-3 Register value view 
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INDEX 

Alphabetical order Meaning 

ADC Analog-to-digital converter 

BE Big Endian 

CLI Command Line Interface 

CSV Comma Separated Values 

DAL Device Access Layer 

DNL Differential Nonlinearity 

FFT Fast Fourier Transform 

FW Firmware 

GUI Graphical User Interface 

HW Hardware 

INL Integral Nonlinearity 

INSTALLDIR Installation Directory 

IP Internet Protocol 

ksps Kilo-Samples Per Second 

LE Little Endian 

MCHP Microchip 

MCU Microcontroller Unit 

S/N Serial Number 

SW Software 

Rev Revision 

PC  Personal Computer 

SPI Serial Peripheral Interface 

TCP Transmission Control Protocol 

USB Universal Serial Bus 
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